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Summary of Key Changes

>

>

Online Mobile Alternative for Offline Mobility!

> V9.4 is 1st Cormant-CS version to be a fully responsive web HTML5 platform and can be a
substitute for offline mobility when needed.

Web Scanning Capabilities which include full support for Bluetooth Barcode Scanning and
Device Camera Scanning (both 2D Data Matrix as well as 1D barcodes)

New “Scan Mode” on web that replicates functionality of current Cormant-CS Windows Mobile
offline application with the following exceptions: Online only, No Audit Module Support and Scan
to Conduit functionality is limited at this time.

Floor Plan Views improved with new nesting floor plans and the allowance of irregular shaped
spaces.

Data Center Plan View Enhancements that include Multi Rack Threshold Colors and Visible
RU’s

Improved Reporting with added pie chart displays to custom reports and dashboards
Export of Report Charts in multiple image formats now available on custom reports

New & Improved Dashboard Widgets

> Alerts & Alerts Summary

> Workflow & Workflow Summary

> Improvements to Custom Report and Plan Widgets

Increased Security Features

© 2002 - 2018 Corman t Inc




Training on New Features
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DCIM And Beyond

Online Mobile Alternative for Offline Mobility

> Version 9.4 is the first Cormant-CS version to
provide a substitute for the Cormant-CS Windows |
Mobile offline application using the fully responsive f,_" | l
Cormant-CS web application.

+] @ 02-Atlanta-DC1 CMDB

> Touch Screen Capability supports a mobile solution T

using browsers on phones and tablets in a 5 W DCIROW)

user/finger friendly interface. M D10

. . % W DCI-ROW3

> Support across PC, tablet and phone is automatic S W OCI-ROWA

using the normal Cormant-CS web URL and will i

work on Apple and Android mobile devices as well o
as devices running Windows 10. ® M UPs02

02-ATL-DC1 e 1o Bockmats

Detatls subcomponents

Plan View Kack View Alerts
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Web Scanning Capabilities with Online Mobility

Cormant-CS V9.4 now contains Barcode Scanning Functions.

> Cormant-CS Web includes full support for Bluetooth Barcode Scanning and attachable
USB Scanners (both 2D Data Matrix and 1D barcodes), as well as Android-based
mobile/pocket PC with dedicated scanner (models similar to Zebra/Motorola TC
51/56)

> A Device Camera can also be used as a barcode reader for scanning purposes.

Bluetooth 1D/2D scanner USB 1D/2D scanner Android Pocket PC with
Dedicated 1D/2D scanner
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Web Scanning Functions — Scan Mode

> Scan Mode imitates the offline Windows Mobile application behavior where scanning a
serial number, asset tag or barcode number will quickly load that asset or connectivity into

Cormant-CS.

> If the barcode is not found, the program will prompt for an option to assign or create a new
record

Asset Details Connections Details| **

us anta DC Building
Assers | North America / USA | Atlanta DC Bullding €1/ DCI-ROW! / DC1-01A
02-Floor / 02-ATL-DCI / DCI-ROWI / DCI-01A
DCI-01A-SVROT
Bookmarks
History Plan View Rack View Ale
History Plan View Rack View Alerts
Discor very
Discovery
Detail Level 3 v | Channel View v Show Spaces
@ Edit B Save Changes % Cancel Changes
i Delete Componenf S

s g

¥ Auto MPO View » Connect Py onnect
[ Show Details & Import Connections

mport Components
B General B 8000905 - Channel - Detail 3
Name

E @ DC1-01A-5W01-CO1

DCI-01A-5VRO1
Description =] (1 8000905
Dell PawerEdge R720 Ultra-compact Rack Server

(=) @ DCI-01ASVROT-CI

sssss

£} = DC1-01A-SVRO1

__ O O
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Web Scanning Functions - Scan Mode

To engage Scan Mode using a scanning device:

» Point your mobile browser to the secured
Cormant-CS Server Web (Https required) and
tap the 2D barcode next to Quick Search to
engage Scan Mode.

» Once in Scan Mode, use an attached scanner
(Bluetooth or USB) to scan a barcode for
recording or searching functionality.

To engage Scan Mode using the camera of your

smartphone or tablet:

» Tap the camera icon next to the Quick Search
bar to use the camera of your smartphone or
tablet as a barcode reader.

O https//mobile.cormant-cs.net/csweb/

Q Quick Search...

& CORMANT-CS’
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Assets / North America / USA / Atlanta DC Building
02-Floor / 02-ATL-DC1

* Return to Bookmarks

02-ATL-DC1
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History Plan View Rack View Alerts
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Web Scanning Functions — Scan Asset (Create New)

> Scanning Assets

> While in Scan Mode, scan a barcode using an external device or camera. If the barcode
is not recognized, you will have the option to assign that barcode to an existing asset, or
create a new asset with that new barcode.

> To create a new one, see example shown below to scan and create:

Barcode

Serial Number

Asset Tag

© 2002 - 2018 Corman t Inc
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Web Scanning Functions — Scan Asset (Assign to Existing)

> To assign the barcode to an existing asset, use steps shown below:

1. Scan first 2. Select attribute to save the barcode value 3. Browse Asset
then tap Assign

. = )

Barcode

Serial Number

Asset Tag

© 2002 - 2018 Corman t Inc



Web Scanning Functions — Connecting Ports

» You can use your mobile in Cormant-CS to connect individual ports with barcode cables

» Connecting Ports is the same as in Cormant-CS Web Desktop browser, but with addition of

barcode scanning to speed up the searching of asset and cables!

Tap and hold to the port
And tap connect
from context menu

? W4GA 62% m 9:13FPM

O [ https//192.168.7.131/csweb/Comp - [ §

I Select Port

Q | Search
B DC1-01A-SW01-C02
O DC1-01A-SW01-C03
@ DC1-01A-SW01-C04
O DC1-01A-SWO01-C05
@ DC1-01A-SWO01-C06
@ DC1-01A-SW01-C07
B DC1-01A-SW01-C08
O DC1-01A-SWO01-C09
@ DC1-01A-SWO1-C10
O DC1-01A-SW01-C12
& DC1-01A-8SW01-C13
O DC1-01A-SWO01-C14
O DC1-01A-SWOT-C15

O DC1-01A-SW01-C16
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Scan or fill in the barcode
cable to be used

v4GA 62% m 916 PM

0t [ https://192.168.7.131/csweb/Comp [

Copper Cables

Scan the end equipment
where the cable will be connected
then select the port you'll use

WG4 60% m 9:26PM

@ 02-Atlanta-DC1 CMDB

% CRAC-01
% CRAC-02
= W DC1-ROWT

) ® DC1-01A

Cancel
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Newly connection
port — switch view

} V4G4 60% m 9:28PM

O [ hitps//192.168.7.131/csweb/Comg

3 Show Detalls & Import Connection:
(=] @ DC1-01A-SW01-C10 - Channel - Detail 5
(= @ DC1-01A-SW01-C10
(= & DC1-01A-SVR01-C3

[¥] == DC1-01A-SVRO1
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Web Scanning Functions - Force Connect

» This is quite a useful function to quickly connect or update several barcoded cables in
a rack. Force Connect (FC), sometimes called, Quick Connect in the offline
Window Mobile application, allows you to use the Cormant- CS Web Mobile to scan
cables connected to a switch or patch panel, quickly and with ease.

» This is typically used on cases wherein there is a newly patched switch or patch panel
and you need to quickly record the connectivity in Cormant-CS .

NOTE: This is slightly different from the normal connect process on the handheld, as it

will not warn if the connection is current or different.

(v [ https//192.168.7.131 /cswen/Comp | & 3
Corn From [SWZ-O! ]E S “
s | J ForceConnect
Quick Connect Catle Type F“*"“"*”‘““’" JIEI | Cormant- CS Web
Offline Windows ™" == C Mobile version

) - length  [2.0 |
M O b I I e Ve rs I O n A:‘DMEJJJE ROTHE3 11007 .
Barcode l ] Carect mnm. From .Clelar

Mohdwtc AuctoCorfrmooon

| Done |fConnect || Diccon || Clear |
€Prev [PNext ®3Undo (Nhedo alb
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Web Scanning Functions - Force Connect

» To use Force Connect, first find the switch or patch panel you’d like to update
connections on.*Note: you can use search or scan the barcode of the switch or patch
panel.

> Next, follow below steps:

1.Tap and hold to the switch 2. Scan the patch cable in the switch
or panel you'd like to Force Connect. and the app will read the port number
Tap Connect from context menu on each port being connected.

3 @404 67% m 8:15PM

5 W4G4 67% m 815PM

O B https://192.168.7.131/csweb/Comp | [ §

(5] & Atlanta DC Building

A 02-Floor
- & MFlOe— —————— W Barcoda

R [ 3. Scan all cables. You can click Next
Omon button for ports that are not connected.
. When complete, tap the Done button to
- make Cormant-CS update the
- - connectivity records
C[':;Y
[ ] Paste
B2 D Shew Ca
E M i::‘ a Al
ROTHO2 SW2 7;231%
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Web Scanning Functions - Move Here

» Move-Here function allows you to scan one or more components to a space. This is
best used after moving several assets, then executing this function.

» To use, go to the new space, room or rack where the equipment was moved to then
follow below steps

Tap and hold to the space
where the asset is moved. Scan using barcode scanner Cormant-CS will warn you if asset is connected.
Tap Move Here function or type-in the barcode # Confirm the move and it will move the asset/s

b 4G4 91% B 1253 AM

3 @4Gd 1% W 12:56 AM £ 9404 91% B 12:56 AM

$ 4G4 92% W 12:51 AM

O Bl heips//192168.7.131/csweb/Comp - @ § O B htipsi//192.1687.131/csweb/Comp. - (@ § O B hitps//192.168.7.131/csweb/Comp @} O B hiips//192.168.7.131/csweb/Comp - [ §
rpen , Quic
North 4
& CMDB 15 Component S component L Storay
BBBBBB Barcods
@ Europe areade 02-ATL-Storage A Return to Beakmarks
50001704 50001706
(=] @ North America [T Add i Comporems | e Name
Il Canada oo
ace.
ace
3@ = UsA 1M [ Edit I Save Chan
() A AtlantaDCE Imj o + add Compon o P
(5] & 02-Floo A Impart Comp
B 02 E General
Name
£ 02 ATLStorage
uuuuuuuuu
E] " elete Descriptior
ut ace
Gony
" FFFFF .
pla
02- Move Here: Foom
= 02- L .. .. 00 o hameen Y S
ity
& 11-Floo]
Assets  North America | US4+ Atlanta DN llapse A
“““““ B Environmental
DC1-MDF A He ol
un Seript: e Move s
Exports
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Multi Level Plan Views in Cormant CS Web

> Nested Plans are now supported. You can overlay plans based on their tree
hierarchy and drill-down to specific spaces. Clicking (or tapping if on a mobile device)
laid out spaces / rooms will open up the plan of that space.

> An example space hierarchy where this works well is having a 1) Campus Site, with
several 2) Buildings where and each Buildings has 3)Floors and those floors have 4)
Data Center rooms or Office Areas, as shown in the example below where each space
has a floor plan that can be drilled down into their child spaces.

R oo |

My Alerts

Max Value 50000 Max Valve 2000 Max Valve 3000 Max Value 45  Max Vave 40
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Multi Level Plan Views in Cormant-CS Web

> Irregular Shaped Spaces is now
supported.

» To add a new point to shape the
plan, go to Edit mode in Plan View

> If the asset is a room, datacenter or
a building, click Unlock Spaces.

> Then, right click and click Edit >
Add Point or Remove point.

> You can define the shape of spaces
and rooms by adding and adjusting
points as needed.

© 2002 - 2018 Corman t Inc
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Assets | Asia/Pacific / Philippines ' BGC / Boni High Street

Boni High Street

Details Subcomponents Connections History Plan View Rack View
& Edit Save x Cancel Grid Options O Show 3D C Rotate Q
Color by: Thresholds... Rack text: Rack Name v | Unlock: Spaces

b 7

&
Boni Tech Center

ne Boni Highstreet 7/
* _ind Museum k.
t 4 o
. )
_—
-

»

y T
/ Bomhi st

Alerts

O Reset

Discovery

& Print

Boni High Street

# Details
Deselect All (1)
Remove from plan (1)
Plan View Image

v Align
Layout Same As...
Make Same Size As...

Save Template




&2 CORMANT"

DCIM And Beyond

Multi Level Plan Views in Cormant-CS Web

> Spaces that are not yet laid out in the floor plan or map are highlighted in . Drag-
and-drop the space/bldg. to the map on the right to lay it out.

> In the example below, the Fort Strip is an L-Shape building. You can turn the default
square mapping into an irregular shape by Editing and adding Points

FOrt Strip
B Asset Tree H
Fort Strip v s : |
Details Subcomponents Connections H
=] & All Spaces
) . i i i # Details
Asia/Pacif Details Subcomponents Connections History Plan V ) ) )
5 @ Asia/Pacific @ Edit Save x Cancel Grid Options
o [# Edit Save % Cancel Crid Options O Show 3D Deselect All (1)
= ’ Philippines Color by: Thresholds... « Rack text: Rack Name
R f lan (2)
= Q?‘ ECC(Has Plan) Color by: Thresholds... ~ Rack text: Rack Name v || Unlock: FmevE from prET s
n EHS Plan View Image
One Boni Highstreet
) Boni High Street
- Align
& EBoni Stopover
Layout Same As..

Make Same Size As.. Make Same Size As...

Save Template
& Mind Mussum Save Template p

Re-Bemimiagl Center
] Fort Strip Q

& One Boni Highstreet - Edit

Add Point
Remove Point

& Terra 28th
R Track 30th
© cMmDE
&) Europe
€ North America

H0r_ini 0

After edit
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Plan Enhancements — Color Coded Alerts & Thresholds

> Multi Rack Threshold Colors have been added to the Plan View to allow user to view color
coded multiple alert thresholds. By default, the plan view will open to Color By: My

Alerts 02-ATL-DC1

Details Subcomponents Connections History Plan View Rack View Alerts Discovery

(@ Edit B Save % Cancel Grid Options & Show 3D C Rotate Q Q O Reset &= Print

Color by: ThreshoD Rack text: Rack Name v

Ez.g“i
 HBER

DC1 ROWS

02-AT1-0C1
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Plan Enhancements - Color Coded Alerts & Thresholds

> The user can select the Color By dropdown menu to see list of existing alert thresholds. A
checkmark will signify the displayed (activated) threshold color alert(s). You can display 1, 2 or 4
alerts. *If 3 alert thresholds are selected, the lower left rack quadrant is grey, indicating no 4t" alert
threshold has been selected. Also,

> It is not possible to select more than 4 thresholds.
> The alerts will display in order clockwise from top left.

@r by: Thresholds... « >

My Alerts

Cooling vs Max v
Power Plate vs Max v
Rack A side AMPS Used
Rack B side AMPS Used

Rack Power Actual vs Power Max

RF Code Temperature
RU Used v

Temperature

” . f
— L
‘ DC1-02C

My Alerts Cooling vs Max Power Plate vs Max Rack A side AMPS Used Rack B side AMPS Used Rack Power Actual vs Power Max RF Code Temperature RU Used Temperature

| Value: 36270 Value: 0 Value: 0 Value: 7440 Vvalue: 0 [ Value:34 | value: 28
Max Value: 50000 Max Value: 7000 Max Value: 0 Max Value: 0 Max Value: 7000 Max Value: 0 Max Value: 42 Max Value: 40

© 2002 - 2018 Corman t Inc
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Plan Enhancements - Alerts Decoder

> Single click on a specific rack, in this example, DC1-02C has been selected, and the Alerts Decoder
will display at the bottom of the screen, showing all aggregated values for captured threshold(s).

> Cool Feature Alert! When in Plan View, you can single click outside of the floor plan then hover your
cursor over a rack alert to see the alerts decoder aggregate values at the bottom. As you move
your hovered cursor over different racks, the alerts decoder will update accordingly providing
accurate alerts data.

/ \ \
B, 7‘ .A‘
- - J
e . ' Wil
| A ‘ ) \
! AL\ \\f \
S 02ATL 1
DC1-02C
My Alerts Cooling vs Max Power Plate vs Max Rack A side AMPS Used Rack B side AMPS Used Rack Power Actual vs Power Max RF Code Temperature RU Used Temperature
* value: 36270 IEERITSCIECH Value: 0 Value: 0 Value: 0 OVallE3AT|  Value: 28

“Max Value: 50000 Max Value: 7000 Max Value: 0 Max Value: O Max Value: 7000 Max Value: 0 Max Value: 42 Max Value: 40
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Plan Enhancements - Alerts Decoder

> If you hover specifically over a color coded alert on a specified rack, you will see the threshold
name. These will match the Alerts Decoder threshold and color coding at the bottom of the screen
These values show the Current Aggregated Value of that threshold and the Max Value configured for

that threshold.

DC1-02C
My Alerts Cooling vs Max Power Plate vs Max Rack A side AMPS Used Rack B side AMPS Used Rack Power Actual vs Power Max RF Code Temperature RU Used Temperature
TP Y Value: 9130 | Value: 0 Value: 0 Value: 7440 Value: 0 [Value:34 |  value: 28
Max Value: 50000 Max Value: 7000 Max Value: 0 Max Value: 0 Max Value: 7000 Max Value: 0 Max Value: 42 Max Value: 40
DC1-02C
My Alerts Cooling vs Max Power Plate vs Max Rack A side AMPS Used Rack B side AMPS Used Rack Power Actual vs Power Max RF Code Temperature RU Used Temperature
~ Value: 36270 Value: 0 Value: 0 Value: 7440 Value: 0 [ Valiei34 | value: 28
Max Value: 50000 Max Value: 7000 Max Value: 0 Max Value: 0 Max Value: 7000 Max Value: 0 Max Value: 42 Max Value: 40
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Plan Enhancements - Visible RU’s

> Individual components in racks are now easily identified on Plan View with Visible RU’s!

> In this example, on rack DC1-01F, notice the individual components and their associated RU’s visible
in GREEN (Note: Cormant-CS supports both front and back rack views.)

Dg1-01F

DC1-01F

© 2002 - 2018 Corman t Inc
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Plan Enhancements - Visible RU’s

> So how do you configure your Plan View to SHOW the Visible RU’s?

> Go to Edit Mode in Plan View by clicking EDIT. In this example, we are editing 02-ATL-DC1. Your Plan View will display
as shown below.

> Next, you must UNLOCK Racks & FMD’s

@ Edit [ Save x Cancel Grid Options & Show 3D C Rotate Q Q O Reset & Print

Color by: Thresholds... « Rack text:

Rack Name v | Unlock: None

)
WS e TR A\ \

© 2002 - 2018 Corman t Inc
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Plan Enhancements - Visible RU’s

© 2002 - 2018 Cormant Inc

Then Single click on the selected rack to edit. In this example, we are unlocking DC1-03G
Then Right click to display the Edit options drop down menu

Select Front. To identify the FRONT of Rack, click on 2 of 4 corner points (squares) to turn them
from BLACK to GREEN, identifying those GREEN as the Front of that Rack. For multiple racks, click
the next rack, performing the same operation of clicking on the 2 square points, turning them from
BLACK to GREEN and continue until all Front of Racks have been identified with GREEN squares.

*You will notice as you pass from identified rack to the next, the racks already defined will display
an "FF”, which indicates Front of Rack.

When finished click SAVE I

\

@,‘

¢='-'-ﬂ\“/’

“FF"” indicates
FRONT of RACK.
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Plan Enhancements - Visible RU’s

» Cool Feature Alert! When adding new racks to Plan View, you can identify the Front of Rack then
Right click and from the drop menu click Save Template and the system will save the Front of Rack
location, making rack adds much more efficient and user friendly.

DC1-01D

# Rack View

Deselect All (1)

Remove from plan (1)

Plan View Image
CRAC-02
~ Align

~ Edit

Make Same Size As_..

' Save Template

Undo

Redo

© 2002 - 2018 Corman t Inc
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Plan Enhancements - Visible RU’s

> Once Front of Rack has been saved, you will notice 2 things:
> All components and Visible RU’s are now displayed on Plan View in GREEN (Show 3D) AND

> The rack will now show a bold outline where the Front of Rack was identified when in Plan View
(Show 2D)

: (2D) >The bold line(s) indicating Front of Rack are purposefully faint
‘ yet noticeable, to offer a subtle indicator without taking away from

/ / rest of plan view layout.
./

/ Y / | T Bl =] o —

7 4 y/ ..... — v - i .

ner-oc m oct-a3c o4 oc1-0se oc1-06e

oct-om 0c1-020 0c1-030 0C1-040 0C1-050 0C1-06D

N - B - o - = —

DC1-0W DC1-02F DC1-03F 0C1-04F DC1-05F DC1-06F

B | bet-0%6 0C1-026 DC1-036 0C1-046 DC1-056 DC1-066

(3D) view of visible RU’s now in GREEN oo oe-ozu scramm | 0C1-0aH DC1-05H 0C1-06H
T e s e N DCIROWS  —
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Plan Enhancements - Visible RU’s

> Hover over any rack component identified in GREEN and a display bubble of component name will
show. Move your mouse over the components in any rack for this feature. In this example, we are
hovering over DC1-01F-SVRO04.

> A SINGLE click on that component takes you to that component in the Asset Tree. You will stay on the Plan View Tab.

> A DOUBLE click on that component will take you to the Details tab of that particular component and you will leave the
Plan View Tab.

B Asset Tree
[=] 4 Atlanta DC Building
“ 01-Floor
= @ 02-Floor
O B8 02-ATLDC]
£ M DC1-ROWT
g DCI-01A
g ociois
§ Dci-01C
§ DCI-01D
B DCI-01E
@ DC1-01F
2 DC1-01F-ConsoleSW-01
== DC1-01F-FPPOT
~ == DC1-01F-FPPO2
N f DCI-01F-PDU-A
B 0 \Q f DC1-01F-PDU-B
IC1-ROWA \ \ ws DC1-01F-SVRO1
A ‘ - ™= \\ - ws DC1-01F SYRO2
7 — -— wa DC1-01F-SVRO3
DC1-01F ] 0 DC1-017-5VRO4]
ws DC1-01F-SVROS
wa DC1-01F-SVR06
ws DC1-01F-SVRO7

®

DC1-01F-SVR0O4

®

®

®

0
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Plan Enhancements - Visible

We understand some customers record

RU’s

&, Audit 1 Reports | 3 Configuration -

*blank

-

blank panels/blanking plates with various
RU’s as part of their Asset Tree. This can
Result in an incorrect recording of available
RU space when searching for a rack unit

location to mount a component. To take L B
into consideration this discrepancy when

recording blank panels of various RU’s,
Cormant suggests setting the blank
panel/blanking plate Mounting Type =
"NONE". This will then show as available
space in your Plan View Tab (Show 3D)/
Visible RU’s.

*If you have a large number of blanking
plates/blank panels, Cormant recommends
updating the blank panel template(s)

in the Desktop Client so that all are defaulted as
Mounting Type = "NONE”".

© 2002 - 2018 Cormant Inc
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-} Generic Drawer 3RU

-} Generic Placeholder 1RU
~Jum Generic Placeholder 1RU - Gray
-} Generic Placeholder 2RU
-} Generic Placeholder 3RU - Gray
Je= Generic Placeholder 4RU
Ju= Generic Placeholder 5RU

- B Generic Shelves

-*_ Generic Spacers

=== Blank 1RU Panel

== Blank 2RU Panel

== Blank Vented 3RU Panel
-2 Fan 2RU Panel

= Spacer Generic 10U
== Spacer Generic 11U
== Spacer Generic 12U
‘== Spacer Generic 14U
== Spacer Generic 17U
== Spacer Generic 19U
.= Spacer Generic 1U
== Spacer Generic 2U
== Spacer Generic 3U
== Spacer Generic 4U
== Spacer Generic 5U
== Spacer Generic 6U
=== Spacer Generic 7U
=== Spacer Generic 8U
==m Spacer Generic SU
=== Spacer Generic Filler
‘..m=m Spacer Generic Filler Thin

-

L

7~
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- ]

B General
Name [Blank 1RU Panel |
Description | |
Template Generic Spacers M1
Type Connectivity Hardware v
lcon Blank 1%n 1RU
Connected lcon Blank 15in TRU
Barcode Link No -
Status Used -
Bl Cabling
Cabling System Manufacturer Generic v
B Environmental
Weight ID l
B Racks e —
Equi T [483 SN |
Mounting Type Rack Front \ v
Slat Size
Unit Height Rack Front/Back
Zero Rack Uni Rack Frort

Floor Standing

Add Attibute  Delete Attibute 4 YVall Mounted hanges
Desktop
Blade/Card
Template Components  Subcomg Rack Front/Back Rey I
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Plan Enhancements — Custom Threshold Alerts Available

> Alerts from Custom Thresholds now appear on Plan View when a script triggers a custom
alert.

» To create a Custom Threshold, go to Alerts module>>Thresholds>>Create+.

> Click Custom Threshold. Notice that Value Attribute and Max Value Attribute are
disabled.

> Custom thresholds are created via scripts. Any situation can generate an Alert.

> Imagine a CRAC unit that can end up in a fault condition. The unit has an SNMP Attribute
“Status” that gets set to “Fault”. A script that checks for this value can be created and
Users warned by creating a Warning or Critical Alert when this is found.

> Components other than Racks can produce Custom Thresholds.

Threshold

ustom Threshold

Name * Custom Threshold for Irina
Value Attribute * -- Value Attribute --
Max Value Attribute * -- Max Value Attribute --

= Threshold Values
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DCIM And Beyond

Plan Enhancements — Custom Threshold Alerts Available

> On Plan View tab, you will now see the newly created “"Custom Threshold for Irina”. Again
a script will need to be configured and applied to the threshold to capture it’s data alerts.

Color by: Thresholds... =

My Alerts v

Active Ports Available
Cooling vs Max

Custom Threshold for Irina v \

Rack Power Actual vs Power Max

RU Capacity

Racks and FMD that has or contains a component

with an alert for the currently selected Custom

Threshold will be colored as follows:

e If the highest priority alert is a warning, the rack
is colored :

* If the highest priority alert is critical, the rack is
colored ORANGE.

e All Racks and FMD that do not have or contain

Details Subcomponents Connections History Plan View Rack View Alerts Discovery
(# Edit Save x Cancel Grid Options O Show 3D C Rotate Q Q O Reset & Print

Color by: Thresholds... « Rack text:

Rack Name v

¥
£
3 ~FOSA HO6A ‘."
-8 1028 1038/ 1058 1068 _J*
™ -+oie -102¢ 03¢ _105¢ _106¢ =
- - 030
m Ny 1020 1050 1060
10 DC1-02E - 1-05E -1-06E b
=+ ~Hee Custom Threshold for Irina ~Ho5F ~1Ho6F \:.T
e 1026 1056 1066 | H
1w .mI -_m ..ml R 2
T ce—pe— ‘,“T'
1
 DCT-ROW3 sy DCT-ROWA ;  DC1-ROWS ;  DC1-ROWG ;
N
e
DC1-02E
My Alerts Active Ports Available Cooling vs Max Custom Threshold for Irina Rack Power Actual vs Power Max RU Capacity
Value: 0
Max Value: 119 Max Value: 50000 Max Value: 10000 Max Value: 42

components with the alert will be colored Gray.
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DCIM And Beyond

Rack View Reminders

> You can also display Device RU positions on the Rack View tab. To activate this option,
click OPTIONS on Rack View Tab and select Device RU, then click OK.

v

DC1-01G Display Options

Details Subcomponents Connections History Plan View Rack View Alerts Discovery

# Edit [ Save Changes % Cancel Changes < % Options ’ & Print  Zoom: B (90%) Rack View: '®/Combined Front and Back

RaCk: DC] -O] G /Separate Front and Back

'Rack Images Only

1 1 1 Active Ports Available Data Center Name: d
42 DC1-01G-FPPO1 | DC1-01G-FPPO1 Value: 35 @
" i - S oiE i Max: 108 Threshold Values: -
i v Cooling vs Max

'_ d Value: 19380 Image Labgls; ¥
39 DC1-01G-SWO1 -01G- HHHHHHHE i Max: 50000
38 DC1-01G-sW02 016G S HEH Rack Power Actual vs Device RU: v
37 - ol Power Max
da DC1-01G-SVRO1 2| Value: 3885

3

. ‘ = Max: 10000

- I = RU Capacity . .
34 DC1-01G-SVR02 b = value: 21 Device Attributes: (Drag to Sort)

=

33 ] Max: 42
32 _ i
1 DC1-01G-5vRo3 pcioic Add  x Delete
39 —— = =
28 DC1-01G-SVR0O4
28
27 L r—— ° B Cancel

DC1-01G-SVRO5 { 2, - . %
26 '
25
24 ] DC1-01G-SVR06
23
22 {

| DC1-01G-SVRO7

21 . | g
20 :
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Rack View Reminders

> The Rack View tab now shows all component’s Rack Unit height based on the template used for
that component.  r.k:- DC1-01C

RU RU
1 1 1 1 1 1
42 DC1-01G-FPPO1 1; 1RU 42 DC1-01G-FPPO1 : g 1RU
M DC1-01G-FPPO2 | 1RU 4 B DC1-01G-FPPO2 - i 1RU
% i k ® {§ 1
39 DC1-01G-SW01 : | 1RU 39 DC1-01G-SWO1 IR 1RU
38 DC1-01G-SW02 : [~ ] 1RU 38 DC1-01G-SW02 I 3 1RU
37 g & 37 =

DC1-01G-SVRO1 i 2RU 2 | DC1-01G-SVRO1 2RU
36 ‘ 5 36 e ;
35 ¢ | 35 il

. I S
34 DC1-01G-SVRO2 ; 2RU 34 = 2RU
33 E 33 :_;
32 - I 32

DC1-01G-SVRO3 : 2RU 2RU
31 | 31
30 " ) 30

. I
29 DC1-01G-SVR04 i 2RU 29 2RU
28 | 28
27 - I 27

5 | — ;

54 DCH)ICISVROS‘ = | 2RU e 2RU
25 - L =1 | 25

. I : :
24 - : E 2RU 24 | DC1-01G-SVRO6 FHHE 2RU
23 ' ; ] 23 &8 BaR
22 22 !
21 <R 21 : 2RU

© 2002 - 2018 Cormant Inc




&2 CORMANT"

DCIM And Beyond

Rack View Reminders

> You can also choose to display up to 3 attributes in a rack in Rack View. In this example we have
added Template Type and Manufacturer attributes to the Rack View. To do this go to Options in
Rack View then click +Add under Device Attributes, search for up to 3 attributes to add then click
OK. You are able to sort them with the Drag to Sort feature. When done, click OK. Results shown
below:

Rack: DC1-01G

.
T 1 2 201

Display Options

42 DC1-01G-FPPO1 i 1RU MPO Chassis 1U-3 ..
Rack View:  ®Combined Front and Back 41 DC1-01GFPPO2 1RU MPO Chassis 1U-3 ..
/Separate Front and Back 40 4

~'Rack Images Only 39

DC1-01G-SWOo1 ' e 1RU Avaya VSP 4850CTS Cisco
Data Center Name: u ol
S 38 DC1-01G-5W02 EE = 1RU Avaya VSP 4850CTS Avaya
Threshold Values: = 37 1
Image Labels: ¥ Display Options e DC1-01G-SVRO1 § 2RU Dell PowerEdge R720 Dell
Device RU: 54 [
Rack View: [®lcombined Front and Back 33

) ) _ Separate Front and Back 34 DC1-01G-SVR02 2RU Dell PowerEdge R720 Ceell
Device Attributes: (Drag to Sort) Rack Images only 33 ] !
Data Center Name: ! " . J A
0 Add x Delete Threshold values: ¥ 3e
7 DC1-01G-SVRO3 | 2RU Dell PowerEdge R720 Dell
Image Labels: ! 3l
i . @ i i |
Device RU: L 30 ! .
29 DC1-01G-5VR04 2RU Dell PowerEdge R720 Dell

Device Attributes: (Drag to Sort)
28

27

Template

Manufacturer

@Add  x Delete e 2RU HP ProLiant DL380 G6 HP
25

o R 24 2RU HP ProLiant DL380 G6 HP
23
22
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Enhancement to Importing Screens

» All web import screens now allow for Date Format Selection! To discover this
enhancement, click on Import Components from the Details tab of the space. The import
screen will display. Notice at the bottom, the drop down selector for the following
Expected Date Formats: [Auanta bc Building

D D/ M M/YYYY Details Subcomponents Connections History Plan View Rack View Alerts Discovery

D D - M M —YYYY [ Edit Save Changes % Cancel Changes + Add Component W Delete Component X Import Components

M M/ D D/YYYY - oene Import Components —

Name Atlanta DC Building

MM-DD-YYYY
YYYY/MM/DD

2 Environmental Root Space:

YYYY' M M = D D Cooling Max 0 Atlanta DC Building
Weight Max 0 Im port Options:

D D/ M M/YY I/ skip Errors _—
M M/ D D/YY ¥/ Check Child Spaces

¥ Create Sub-Com ponents

YY/ M M/ D D ¥ Check Child Templates

) Run Scripts After Import

[ynnort comnanante from file i

) Zero Fill Numeric Ranges

Component Creation Option:

*The selected date format will be saved for the

entire session. <)a:“m"\ |

l DD/ MM/YYYY / v ‘

v

Verify Cancel
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Enhancement - Forget Decisions

» We have added many "Remember Decision?" prompts attached to the users login name
when performing an action. In v9.4 we have included the option to Forget Decisions
under the User Name at the far right of the Cormant-CS web screen. Taking this action
to forget decisions can be especially useful for multiple scan-and-connect decisions where

remember decisions can be both very helpful and very dangerous.
» After clicking on the Forget Decisions menu item, any confirmation prompts which had

previously been remembered (by checking the "Remember?" checkbox) will appear again
the next time that they should be encountered

Confirmation Required

& Administrator

Not all components can support application "100 Base TX'
Change User Profile Settings
Do you wish to continue? FIJ'T'EE"I Decisions
Toggle camera scanner
R ber?
emembe About

T
Help

Log Out

ol Decisions Forgotten
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Improved Reporting Features - Pie Charts

> In the Reports Module, a user can now run a report and choose to display results as a
Pie Chart (in addition to the Bar Chart previously existing display option).*This is also
true on the Dashboard Widget display for Custom Reports. (See Slide 44)

Chargeback Report

Show Details Show Bar Chart Show Pie Chart ’ = Refresh & Export PNGC v

@ None [J Finance [JHR  Marketing [[] Operations [[] Sales

Chargeback by RU
ils Show Bar Chart Show Pie Chart Z Refresh & Export PDF ¥ Portrait

Name Template Equipment Owner Unit Height
Equipment Qv N Sum: 126
Equipment Ov Fi sum: 116
Equipment Owner: HR Sum: 272
Equipment Ow IT Sum: 8
Equipment Owner: Marketing Sum: 58
Equipment Owner: Operations Sum: 172
Equipm Ow sal Sum: 100

Total Sum: 852

Page 1 of 1 Rows 10 v -

Displayed Time: 26/06/2018 09:42:51
Last Updated: 26/06/2018 09:42:51
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Improved Reporting Features — Export Formats

> The Export feature of run Reports when Showing Pie Chart results includes additional
export format options as shown below. The user can now select from PNG, JPEG or
PDF formats. These enhancements offer a more professional graphical export
functionality for presentations to management.
> PNG - Allows for transparency of background on the pie chart image

Chargeback by RU

Show Details Show Bar Chart Show Pie Chart < Refresh & Export ‘ PNG v ‘

[ None [ Finance [JHR | IT [ Mark<reers
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Improved Reporting Features — OnRun Filter ’

> You can now configure Custom Reports and Scheduled Reports to prompt you to add
filter values when triggering the report to RUN. We call this feature OnRun within the
Reports module.
» To configure a Custom Report to prompt you for filter values at the time you Run a report, you will
need to activate the OnRun feature in the Custom Report, as shown below in this example.
» Click Save, then click RUN
*Please note Caching cannot be enabled if the report has OnRun filters set. ( \

Chargeback Report

So WHY did Cormant
Details design this feature?

® Run [# Edit Save % Cancel + Add Report + Add Folder W Delete

& Report Details v Being able to schedule an

Name Chargeback Report Report Chargeback Report existing report and adding
Titl .
e the necessary filters at run
Report Asset Reports v Caching (Caching can't be enabled if the report has On Run filters) :
Folder Enabled time reduces the # of
Report Normal Report v reports being generated =
e EFFICIENT
E Filters
On
Join Attribute Comparison Value Run v Guarantees the same
» - report IS belng run every
Where Space Includes v + f N
time. =
= And v Space Not Equals v 02-Atlanta-DC1 CMDB | = L ) STANDARDIZED &
RELIABLE
= And v Template Includes v Network Equipment - Server Equipment - Storage Equipment - + ! ]

Add Filters \ J
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Improved Reporting Features — On Run Filter

> If /When OnRun filters are set, a popup dialog will display requiring you to define the
OnRun filters before running the report.

> Once OnRun filters are defined by selecting the “+” and adding those values, click OK.
» The report will run accordingly and display the resulting data.

You must define On Run filters before running the report

On Run Filters

Join Attribute Com parison Value Value

Where Space Includes + - 02-ATL-DC1 - +

Chargeback Report

Chargehack Report

e ar = Refr
None [] Finance [ HR | Marketing [] Operations [] Sales
OK Cancel
Show Details Show Bar Chart Show Pie Chart < Refresh

Name Space Template Unit

Equipment Owner: None

Equipment Owner: Finance

Equipment Owner: HR
Equipment Owner: Marketing Re S u Its !

Equipment Owner: Operations

Equipment Owner: Sales

Rows 1 to6of6
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Improved Reporting Features — On Run Filter ’

> The OnRun feature is similar when configuring Scheduled Reports

» To configure a Scheduled report and incorporating the OnRun feature, go to New Scheduled Report,
then click Edit.

> Select the Report from the dropdown menu you would like to set a schedule for.

> The OnRun Filters option will now appear and you can set the filter values as desired, as well as the
report schedule, then click Save.

New Scheduled Report

Details

@ Run [ Edit B Save ® Cancel + Add Report W Delete

= Report Details

Reporting Type Archive v File Name /
Attachment
Scheduled Report Chargeback Report v Output File Location

Note: The folder must be accessible on the Server

Schedule Name New Scheduled Report File Format Ccsv v
| Enabled Lasiiodared By Adminicirator
= 0n Run Filters
Join Attribute Comparison Value
Where Space Includes +
= Report Schedule
Occurs Weekly v
Every 1 Week(s) on 0 Sunday [ Monday |~ Tuesday L Wednesday L. Thursday

|0 Friday [ Saturday
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New Dashboard Widgets and Improved Features

> Cormant-CS Dashboard has improved existing features on the Floor Plan configuration widget,
added pie graph displays to Custom Reports Widget and has added 4 brand new dashboard widgets
to its list of offerings. These new widgets are:

> ALERTS (MY ALERTS) Widget

> ALERTS SUMMARY Widget

> WORKFLOW (MY TASKS) Widget
> WORKFLOW SUMMARY Widget

02-ATL-DC1 - Rack Power Actual vs Power Max

instail |

My Alerts - Assigned within 60 Days - Shown/Total- 6/6 E Tasks by Status (All Sites) Decomission -
[open Weostponea [Waming [lcritical [ Being Plansed [ Walting For Change [ in Progress || Waiting For Customer Information Modify
Assigned Date Rack/Device Description - v Rename |
<Im ago DC1-01B Threshold Exceeded: Move -
Rack Power Actual vs Incid |
Power Max (7619 W / ncident
IO Atlanta DC Buibkding - Total Alerts
<1m ago DC1-01A Threshold Exceeded:
Cooling vs Max (36497 Atlanta DC Building - Alerts by Type
/ 35000 )
30
< EED 200 Zgroelf:;lxi ﬁ;ﬁi‘;g"‘m Warning - Open Warning - Postponed Critical - Open Critical - Postponed /2018 12:20:05
/ 35000 ) - 15
<lm ago DC1-01B Threshold Exceeded: 10
RU Used (35 /31.5)
<1m ago DC1-01B Threshold Exceeded:
Power Plate vs Max 5
(9270 W / 8820 W)
<1m ago DC1-02A Threshold Exceeded: 0 s
RU Used (36 / 35.7 ot f @t N
e ; 9\"5@ au®® e ™ G\Qe‘a\
o et T
‘?D Desplayed Time: 2008,/06,/78 15:24°46
Last Updared: 2001 8,/08,/28 15:24:46
Last Updated: 10/07/2018 11:37:33 Last Updated: 10/07/2018 12:02:48

© 2002 - 2018 Cormant Inc



&2 CORMANT"

DCIM And Beyond

Plan Enhancements on Dashboard

> The Floor Plan dashboard widget has a new multi-select threshold dropdown for displaying the plan
view with multi color coded threshold alerts. Just select, Coloring dropdown and select up to 4
thresholds you would like to display on your floor plan widget.

> You can also customize the Text on each rack in the floor plan widget using the selection options
under Text dropdown. Options include
> None - shows no data on racks, only color coding for thresholds
> Rack Name - displays the Rack Name on each rack
> Rack Info - displays the threshold

02-ATL-DC1 - Rack Power Actual vs Power Max

Component 02-ATL-DC1 -
[ Thresholds... - ]
Text ‘ My Alerts |
‘ ool v e
L ) Power Plate vs Max
Grid Pixel Spacing ‘ |
cm) Rack A side AMPS Used
Component 02-ATL-DC1
| Rack B side AMPS Used
Rack Power Actual vs Power Max v Coloring Thresholds... -
Refresh Interval ‘ | L
RF Code Temperature @ Rack Name
' RUUsed
Temperature | None
— Grid Pixel Spacing
(cm)
Rack Info
Refresh Interval 5 z 3
Last Updated: 10/07/2018 08:37:56
Automatically refresh every 5 minutes
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Plan Enhancements on Dashboard

» Plan View widget will now hold zoom and save that zoom level where you last left off.
NOTE: Storage of the Zoom is on a Per Plan basis and will last across sessions.

02-ATL-DC1 - Cooling vs Max

Last Updated: 20/06/2018 10:47:03
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New Dashboard Widget Feature

> When adding a new Custom Report Widget to your Dashboard, there is now an added
feature in the dropdown menu to select the display of the data as a Pie Chart, in
addition to the Bar or Stacked Bar Graphic display. See configuration options/results
below:

Assets Count by Manufacturer - Assets Count by Manufacturer - Assets Count by Manufacturer

Report Assets Count by Manufacturer Report Assets Count by Manufacturer v
Report Assets Count by Manufacturer v P Y v
) Chart Bar v Chart c v
Chart Pie v
Orientation @ Horizontal () Vertical Orientation () Horizontal (8 Vertical

Display Legend [+

Display Legend Display Legend [

Refresh Interval 5

Refresh Interval 5 Refresh Interval 5

Autgmartically refresh every 5 minutes ) )
Automatically refresh every 5 minutes Automatically refregh every 5 minutes

Save Cancel cancel Cancel

Assets Count by Manufacturer

Assets Count by Manufacturer Assets Count by Manufacturer

O None [ Cisco [ Dell  F5 [J HP

Il Template (Count) B Template (Count)
50
None
40
Cisco
30

Dell .

20

F5 l

10
s T

0 I .
Displayed Time: 2018/06/28 14:30:55 0 10 20 30 40 50 None Cisco Dell F5 HP

Last Updated: 2018/06/28 14:30:55 Last Updated: 11/07/2018 11:18:42 Last Updated: 11/07/2018 11:19:17
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> We have added two new ALERTS widgets to the Dashboard Add Widget menu
> ALERTS (MY ALERTS)
> ALERTS SUMMARY

My Alerts - Assigned within 60 Days - Shown/Total: 1/1

Add Widget

[Clopen Wrostponed [Warning [Cleriticat
- Assigned Date Rack/Device Description
Historical Report Add 22d 23h 12m ago DC1-02C Threshold Exceeded- Rack Power
Displays a historical report as a line chart Qﬂ“”al vs Power Max (7391 W / 8850

Last Updated: 2018/06/28 14:35:59

Custom Report Add

Displays a custom report as a bar chart.

Atlanta DC Building - Total Alerts
Plan View Add

Warning - Open Waming - Postponed Critical - Open [] Critical - Postponed

Displays a plan view of a space in 2D or 3D

Alerts Add

Displays a list of alerts assigned to the
[ current user.

- ‘ Alerts Summary Add

Displays a summary of existing alerts as a

U _J

Displayed Time: 2018/06/28 15:24:46
Last Updated: 2018/06/28 15:24:46
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New Dashboard Widgets - My Alerts Widget @ conmant

> ALERTS (MY ALERTS) Widget displays a list of alerts assigned to the current user. NOTE: The
user must first create a subscription to each alert type in order for ALERTS (My Alerts) Widget to
display all subscribed-to alerts within the date parameters assigned.

» To configure the Alerts (My Alerts Widget), enter the parameters for which you would like to
report your Alerts, then click SAVE.

> Once the Alerts (My Alerts) Widget has been created, your My Alerts Widget will display on

your DaShboardl as Shown beIOW' My Alerts - Assigned within 60 Days - Shown/Total: 6/6 .
My Alerts - |:|Open .Postponed D\\’amiug [critical
Assigned Date Rack/Device Description
Assigned in the last 60 Day(s) v <1m ago DC1-01B Threshold Exceeded:
Rack Power Actual vs
Max Rows 20 v Power Max (7619 W /
6300 W)
Ord N T First
rder CwiestrIrs M <1m ago DC1-01A Threshold Exceeded:
Cooling vs Max (36497
Refresh Interval 5 /35000)
Automatically refresh every 5 minutes <Im ago DC1-01B Threshold Exceeded:-
Cooling vs Max (36748
Cancel / 35000)
<1m ago DC1-01B Threshold Exceeded:
RU Used (35 / 31.5)
Last Updated: 10/07,/2018 11:33:53
<1m ago DC1-01B Threshold Exceeded:

Power Plate vs Max
(9270 W/ 8820 W)

<1m ago DC1-02A Threshold Exceeded:
RU Used (36 / 35.7)

Last Updated: 10/07,/2018 11:37:33
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New Dashboard Widgets - My Alerts Widget @ conmant

> The Alerts (My Alerts) Widget consists of 4 Alert Types,

broken into 2 subcategories of Status and Criticality My Alerts - Assigned within 60 Days - Shown/Total: 6/6
. —
as fO”OWS ) <\D0pen W ostponed [ IWarning DC@
Assigned Date Rack/Device Description
STATUS CRITICALITY <1m ago (12/07/2018 DC1-018 Threshold Exceeded:
21:15:43) Rack Power Actual vs
» OPEN » WARNING Power Max (7619 W /
6300 W)
» POSTPONED » CRITICAL
<1lm ago DCI-01A Threshold Exceeded:
Cooling vs Max (36497
/ 35000)
STATUS color coding references the Assigned Date column in the My Alerts widget <1m ago DC1-018 Threshold Exceeded:
[(Jopen A Status = OPEN indicates the Alert has been assigned and awaits action. Cooling vs Max (36748
Beostponed A Status = POSTPONED indicates the Alert has been Postponed /35000)
<1lm ago DC1-01B Threshold Exceeded:

CRITICALITY color coding refers to the Threshold settings of the alert itself. RU Used (35 /31.5)

[ fwaming A Criticality = WARNING indicates the alert is in the warning percentage threshold value <Im ago DC1-018 Threshold Exceeded:
of that alert as set in the configuration of that threshold in the Alerts Tab>> Thresholds. ?;;%Sﬁ;;g:'ﬁ

[lcritical A Critiality = CRITICAL indicates the alerts has hit the critical percentage threshold value

of that alert as set in the configuration of that threshold in the Alerts Tab >>Thresholds. <1m ago DETozA Threshold Exceeded:

RU Used (36 / 35.7 )

In the example to the right, notice there are 5 OPEN Status alerts (as shown in
white) and 1 Alert that has been POSTPONED (as shown in grey). There are Last Updated: 10/07/2018 14:16:07
4 Alerts in WARNING Ciriticality (as shown in pale yellow) and 2 alerts that are
in Critical status (as shown in pink) and need immediate attention.
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New Dashboard Widgets - My Alerts Widget

» Clicking on the Rack/Device link will send you directly to the ALERTS tab of that device. From
here the user can see all details of alerts for that device, including status, priorities, data center

My Alerts - Assigned within 60 Days - Shown/Total: 6/6

DOpen .Postponed D\\'aming [Ceriticat
> Assigned Date Rack/Device Description
<1m ago DC1-01B Threshold Exceeded

Rack Power Actual vs
Power Max (7619 W /
6300 W)

<lm ago Threshold Exceeded
Cooling vs Max (36497
/ 35000)

<1m ago Threshold Exceeded
Cooling vs Max (36748
/ 35000)

<1m ago DCI1-01B Threshold Exceeded
RU Used (35 /31.5)

<1m ago DC1-01B Threshold Exceeded:
Power Plate vs Max
(9270 W / 8820 W)

<1m ago DC1-02A Threshold Exceeded:
RU Used (36 / 35.7)

Last Updated: 10/07/2018 11:37:33

© 2002 - 2018 Cormant Inc

and a description of the alert itself, along with the assigned user
and postponement date, if applicable.

DC] '0] B * Return to Bookmarks

Details Subcomponents Connections History Plan View Rack View Alerts Discovery

B Filter Options

Status Priority

Assigned Subscription All Subscriptions v Apply filters
Al v ¥ Open # Warning
() Postponed @ Critical Threshold All Thresholds v Reset filters
) Resolved
Actions Export Refresh &
Date Created Status Priority Data Center Rack/Device Description Value Assigned User Postponed Until
() | 28/05/2018 13:37:49 Open Warning 02-ATL-DC1 DC1-01B Threshold Exceeded: 7619W Irina Astrom
Rack Power Actual vs
Power Max
(] 28/05/2018 13:37:49 Open Warning 02-ATL-DC1 DC1-01B Threshold Exceeded: 36748 Irina Astrom
Cooling vs Max
[ 28/05/2018 13:37:50 Open Warning 02-ATL-DC1 DC1-01B Threshold Exceeded: 35 Irina Astrom
RU Used
i 28/05/2018 13:37:50 Open Critical 02-ATL-DC1 DC1-01B Threshold Exceeded: 9270 W Irina Astrom

Power Plate vs Max

Page 1 of 1 Rows 5 v -
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New Dashboard Widgets — Alerts Summary Widget

> ALERTS SUMMARY Widget displays a summary of all existing alerts as a chart (Pie Chart, Bar or
Stacked Bar). This is an excellent management tool for a NOC and senior managers specifically, as a
user can easily view all alerts for a single space or a number of sites/buildings associated to their
data centers. *Examples of configuration/results on next slide.
> To Configure the Alerts Summary Widget, you will need to determine the following parameters:

> SUMMARY - Do you want to summarize the displayed data for a Single Space, Child Spaces or Alert Types?

Note: Both Single Space and Child Spaces will show ALL alerts that exist on the selected space. The main difference is on how each
display the data. Alert Types will show a summary of alerts by alert type.

> Single Space: groups alerts by Status (Warning or Critical).

> Child Space: groups alerts according to the Group Level Options: Atlanta DC Building - Total Alerts
> Direct Child: groups by the first level children of the selected space. _
> Site: groups alerts by Site summary single Space v
> Datacenter: groups alerts by Datacenter Space Atlanta DC Building
> SPACE - What Space in the asset tree will the widget be Summarizing Alerts for?
> CHART - What type of chart do you want to display the data called for? — Chart Bar Y
> Bar Chart, Stacked Bar or Pie Chart Orientation @® Horizontal () Vertical
> ORIENTATION- Will the Alerts Summary display Horizontally or Vertically? Refresh Interval :
> REFRESH INTERVAL - How often (in minutes) would you like the widget : :
to refresh data? u Automatically refresh every 1 minute

Save Cancel

© 2002 - 2018 Cormant Inc
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DCIM And Beyond

New Dashboard Widgets — Alerts Summary Widget

> ALERTS SUMMARY Widget Single Space and Alert Type Configuration/Results examples shown

: S S Atlanta DC Building - Total Alerts -
Atlanta DC Building - Total Alerts - AL DIE AT )= Tl e
Waming - Open | \Warning - Postponed [ Critical - Op Warning - Open \Warning - Postponed Critical - Open [] Critical - Postponed

Space Atlanta DC Buildin
’ ’ Results Waring
Chart ‘ Bar v ‘
Orientation (® Horizontal () Vertical
Refresh Interval 1 Critical

Automatically refresh every 1 minute

_ 0 2 4 6 8 10 12
Save (ISR Last Upd Displayed Time: 10/07/2018 11:55:51
Last Updated: 10/07/2018 11:55:51

: Atlanta DC Building - Alerts by Type -
Alerts Summary ] 9 y lyp
Waming - Open Warning - Postpened Critical - Open Critical - Postponed
Summary Alert Type v 15
Space Atlanta DC Building
10
Chart Bar v R It
Orientation () Horizontal (8 Vertical 5
Refresh Interval 5 % ‘ 5
Automatically refresh every 5 minutes 2+ e cl e
y ry . \ﬁ\\l\ Qv W oo Qeﬁﬁ\
Goo\\“g ) o e
Last Updated: 10/07/2018 12:02:48
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New Dashboard Widgets - Alerts Summary Widget e

> ALERTS SUMMARY Widget for Child Spaces Conﬂguratlon/ResuIts example shown below:
*Space changed from ATL Data Center to USA

USA - Alerts by Children - & Edit

USA - Alerts by Children

\Waming - Open \Waming - Postponed Critical - Open Critical - Postpor o Refresh
‘Summary Child spaces , v 7 B View USA
Space R B View 02-ATL-DC1
Group Level Datacenter v 6 B View 02-VIR-DC2
Chart Bar v 5 B View DataCenter
Orientation O Horizorjial @ Vertical RGSU'tS & Delete
Refresh Interval 0 4
Refresh disapled. - - ,
2
1
00—
02-ATL-DC1 02-VIR-DC2 DataCenter
Last Updated: 2018/07/12 08:28:14
» Cool Feature Alert! Clicking on the “...” 7
in the upper right hand corner of these widgets I
. . # Edit
will offer a dropdown menu not only to edit, refresh | e 2
. . . . B View USA
or delete the widget but it also provides clickable
B View 02-VIR-DC2
links to all the Group Level Options selected for the
data display (In this example, all datacenters).
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New Dashboard Widgets - Workflow B

> We have added two new WORKFLOW widgets to the Dashboard Add Widget menu
> WORKFLOW (MY TASKS)
> WORKFLOW SUMMARY

My Assigned Tasks - BP - Shown/Total: 3/3

Add Widget Task Reference Scheduled Date Task Type Status Device Nam
Plan View Add 000007-00017 Install Being DCIM-SRV
= Planned
| | Displays a plan view of a space in 2D or 3D.
- . 000001-0003 Maove Being DL380 HD
Planned
000003-0002 Install Being
Alerts Add Planned
! Displays a list of alerts assigned to the
I ! Current user. 4 »
Last Updated: 10/07/2018 14:50:54
= -‘ Alerts Summary Add
Displays a summary of existing alerts as a
chart.
Tasks by Type (All Sites)
’ ) ) - WorkFflow Add [ Install [] Decomission [] Modify ~ Rename [] Move [] Incident [ Other [] Admin

Displays a list of tasks assigned to the
current user.

Workflow Summary Add

Displays visual summaries of tasks for

i particular area(s) (Queue). ‘

- Displayed Time: 10/07/2018 14:51:48
Last Updated: 10/07/2018 14:51:48
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) ™
New Dashboard Widgets — My Tasks Widget @ ComMANT

> WORKFLOW (MY TASKS) Widget- Workflow has the concept of orders and tasks, where an
Order is something that needs an action (e.g. a project or an incident), which is then divided into
tasks (e.g. install a server, decommission an equipment, etc). This widget displays a list of tasks
assigned to the current user.

> To configure the WORKFLOW (My Tasks) Widget, enter the parameters for which you would
like to report your task assignments:

> User Type - Determine which user type you would like to report workflow tasks on.
Assigned Operator or Customer?

> Assighed Operator - Person designated to perform the task
> Customer - Person who requested the order (typically internal customer)

» Once the WORKFLOW (My Tasks) Widget has been created, your My Tasks Widget will display
on your Dashboard, as shown below:

My Tasks —

User Type \ Assigned Operator v | Task Reference Scheduled Date Task Type Status Device Nam

Task Status #| Being Planned

L 000007-0001 Install Being DCIM-SRV

[ Waiting For Change Planned

0 In Progress

() waiting Customer Information — 000001-0003 Move Being DL380 HD
Max Rows 10 v Planned

Order Newest First

000003-0002 Install Being

Refresh Interval 1 Planned

© 2002 - 2018 Corman t Inc



) ™
New Dashboard Widgets — My Tasks Widget @ ComMANT

» Clicking on any Task Reference link will send you directly to that Task in the WORKFLOW
module. From here the user can see all details of the task assigned to them, including Order
Details, Task Details, Device Details, and more..

DCIM Server

Task: 000007-000

aevice: DCIM-SRV, Destination: 02-ATL-DC1\DC1-ROW5\DC1-05C

Edit Save Changes Cancel Changes Add Task Mark Complete Export

Order Details Task Details Device Details Subcomponents Details Provisioning Activity Shipping

My Assigned Tasks - BP - Shown/Total: 3/3

2 Order Details
Task Ref Schedyled D Task T S Device N
das ererence che 0 Date as Ype tatus evice Nam Orl:ler ID 000007 OrdEr Name DEplUY DCIM Server
Install Being DCIM-SRV
Planned Order Status Active CAPT #
000001-0003 Move Being DL380 HD
Planned Service Now Link EMP Request ID
000003-0002 Install Being . .
Planned Business Area Project Code Planning Asset Location
4 » Customer Brad Beamish - ADMIN Incident Number
Last Updated: 10/07,/2018 14:45:34 Completion Date Time IDMD =
Update Date Time 10/07/2018 Create Date Time 03/06/2016
Update Username Brad Beamish - ADMIN Create Username Brad Beamish - ADMIN

B Description

No description provided

© 2002 - 2018 Cormant Inc




&2 CORMANT"

DCIM And Beyond

New Dashboard Widgets — Workflow Summary Widget

> WORKFLOW SUMMARY widget - Displays visual summaries of tasks for particular area(s) in a
queue.
> To Configure the Workflow Summary Widget, you will need to determine the following parameters:
> QUEUE - What Site (or all sites) do you want to report workflow summary on?
> SUMMARY - How do you want the results to be summarized? By Task Type or by Workflow Assignment Status?
> CHART - What type of chart do you want to display the data called for?
> Bar Chart, Stacked Bar or Pie Chart
ORIENTATION- Will the Alerts Summary display Horizontally or Vertically?
REFRESH INTERVAL - How often (in minutes) would you like the widget
to refresh data?

Tasks by Type (All Sites .
Workflow Summary - y Type ( )

Queve Al sites . nstal -
Decomission -

Summary Task Type v Modify '
Results> e

Y Vv

Chart Bar v Rename
. . Move
Orientation (® Horizontal () Vertical -
Incident
Refresh Interval 0 i
Other
Refresh disabled. Admin

Cancel 0 10 20 30

Last Updated: 10/07,/2018 12:20:05

© 2002 - 2018 Cormant Inc
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New Dashboard Widgets — Workflow Summary Widget o

WORKFLOW SUMMARY widget display examples Tasks by Type (Al Sites)

e - st [
Decomission
Queue All Sites v Modify
Rename
Summary Task Type v |
vove |
Chart Bar v Incident
Orientation ® Horizontal () Vertical Other
Refresh Interval 0 Admin
Refresh disabled. 0 1 2 3
Last Updated: 16/07/2018 08:49:58

Tasks by Type (North America)

Tasks by Type (North America)

[ Install ] Decomission [] Modify =~ Rename [[] Move [] Incident [T] Other [7] Admin

Queue Morth America v
Summary Task Type v >
Chart Pie v
Refresh Interval 5

Automatically refresh every 5 minutes

Cancel Displayed Time: 2018/06/29 14:51:26

Last Updated: 2018/06/29 14:51:26
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DCIM And Beyond

Increased Security - Summary

» This version is our most secured product to date. It includes recent security fixes
for common web attacks

> Password Brute-force attack via login configuration restrictions
> XSS attack (cross-site scripting) security fixes

> Cross-site request forgery (CSRF) attack security. A cryptographic generated token that
is associated on user session is use. This token gets validated along the user’s cookie in
the server to prevent CSRF impersonation

> Attachment of allowable files is now configurable in web.config of CS Web
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DCIM And Beyond

Increased Security - Password Brute-force attack

Password Brute-force attack via login configuration restrictions are configured as

follows:
83 Cormant-CS
File Edit View Diagram Network Tools Help
. . . & Audit | 85 Options — O X
> By default, Cormant-CS allows multiple login retries. 5 el { 2 UserSetigs 5 Sytom Setings . Mot Conturatin . Hanchld Atdes
1 H H H Settings
> You can secure this by configuring the security vt ess 5 Bl St e
behavior of an account. O Loo Wekdow To ooy (7 oo
. . . - [ Being Planned
> Login to the Cormant-CS Client and click Tools > Options [ Lo Scrpt to Htory \:‘:igg&mge
> In the Option window, go to System Settings tab (1 Send sk Assgned Enc %i‘c}iz’“"“”"“’”“
mplet
> Security group allows you to set the ff:
Server Paths
> Password Complexity Strength Backup Path | | |
> Max Invalid Logins (0 means infinite). *Recommended setting is 3. pemasinto i adecranae,
> Password validity days can be set to force user to change after x fwewm bepocabes l\
number of days in Password Change Days S;"zdw o D1 Max knvekd Logrs [0 = ‘
> Min Change hours allows you to set the number of hours before a Password Change Days [0 3] [ Handneid Usemame As Text
user can change his password again VinGrengetion 0 =] [ Deete Hancheld 0B
B
\ 0K Cancel )‘
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Increased Security — API security Enhancements & €2 CORMANT'
Support for AD/LDAP Authentication

API security enhancements and support for AD / LDAP authentication for calling API
Methods Attachment of allowable files is now configurable in web.config of CS Web

» Configure your IIS virtual directories to Windows Authentlcatlon by enabling this in IIS
Manager > Authentication module T

> Disable Anonymous, then enable Windows Authentication
> Do this for both CSweb and cswebapi virtual folders

> You can also enable AD/LDAP Authentication by ?x,“;”:{‘::',:;“”‘"‘ gﬂi:’m B
configuring web.config and setting the correct values ‘ 3““:::: gm“'{.:‘j ;25 1 ot
for your domain. ' 3 s [ ittt a3

> Lastly, make sure to enable uselLdapForAuthentication in web.config of CSWeb

________________

<section name="ldap-configuration"
</configSections>
kldap-configuration enabled="fal
<applicationSettings>
<Helpers.Properties.Settings>
<!--Uncomment these connection string properties if Cormant-CS8 Server is not installed on the same machine as the Web server -->

type="Helpers.Config Sections.LdapConfigurationSection, CableSclve Helpers"/>

" useldapForAuthentication="true" dom)in="SLOl.cinc.cormant.biz:389" container="DC=cinc,DC=cormant DC=biz" username=""

*For complete details on setting up AD and LDAP for your Cormant-CS, there’s
a Knowledge Base that Cormant Support can send you upon request.
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Increased Security - File Attachment Filtering

Attachment of allowable files is now configurable in web.config of CS Web

> There are 2 new variables in CSWeb\Web.config : ExtensionWhitelist and
ValidateZippedFileExtensions. These control what files can be uploaded as a Workflow Task
Attachment.

> You can add or remove file types based on your security requirements
> It will also scan the content of zip files if all files inside it are allowed, by checking the file extension.

I
<!—— Allowed file extensions for Workflow Task Attachment uploads -->
<setting name="ExtensionWhitelist" serializeRs="Xml">
<value>
= <Array0fstring xmlns:xsi="http://www.w3.o0xrg/2001/XMLSchema-instance"” xmlns:xsd="http://www.w3.0xrg/2001/XMLSchema":>

<string>.doc</string>
<string>.docx</string>
<string>.xls</string>
<string>.xlsx</string>
<string>.ppt</string>
<string>.pdf</string>
<string>.rtf</string>
<string>.txt</string>
<string>.zip</string>

</Arrayofstring>
</wvalue>
</setting>
<!—— Whether or not to walidate file extensions of files within a zip archive according to the ExtensionWhitelist (abowve) ——>
=] <setting name="ValidateZippedFileExtensions" serializelAs="String">
<value>True</value>
</setting>
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DCIM And Beyond

Information & Other Training Resources

» Release Notes v9.4 can be found in the
release package on the Cormant website, using
your secure user login credentials on the

the Customer Portal.



http://www.cormant.com/
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DCIM And Beyond

Information & Other Training Resources

» If you are coming from a previous version and would like reference to the
Summary of Key Changes in prior New Features Trainings, here they are!

V8.4

» Enhanced Rack View and Row-Rack View

Import on the Web

Rack Connections and Power Affected Devices Export
Location Identification, Activity history and Unique links
Creating new users via the web

Template types

Secure password options

Additional administration logs

Database checking -CheckDB

Historical data comparison (example RU, Power, Temperature)

>
>
>
>
>
>
>
>
>
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Summary of Key Changes v9.0, v9.1 & v9.3

v9.0
» Asset Tree improved and completely removed from Cormant-CS Client

» Cormant CS-Web Asset Tree Functionality Enhanced to include a drag and drop Connections
feature

» Plan removed from the Client and now improved and fully on the Web
» Floor Plan Widget available on the Web Dashboard.

vo.1

» Reporting: Continued migration & enhancement of features from the Client to the Web to include
Editing & Running of Reports, Scheduling Reports, and Historical Report Configuration.

» User Security: All Admin, Roles, Zones, Permissions and User Account Management has also
relocated to the Web.

> Report Caching Services feature has been added to the Web for faster loading of reports and
Dashboard widgets

V9.3

> Network Discovery: This function allows you to discover SNMP devices within a range of network
you have configured.
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Online Help

» Our Help System can be found on Cormant CS-Web, our web based platform
(though also still available on Cormant CS-Client).

» To access the Online Help feature:
»> On Cormant-CS Web, click on your UserName in the Top Right Corner

» From the dropdown menu, click Help
& Administrator

Change User Profile Settings

About

Log Out

> You will be welcomed to the Cormant Help Feature in a new tab!
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DCIM And Beyond
|l welcome to Cormant-CS
L] what's New in Cormant-CS 9
O I 1 H I =] New and Enhanced Security Feature
n I n e e p =) Handheld Security Features
=) CSWeb User Profile page
=] Custom Exports
. . . . . . =) Windows Log-in
» Online Help is divided into 5 major sections 8) one Component Permissions
[ Using the Web
[l Asset Console

> What's New in Cormant CS-9? [l Managing Components

Bl Rack view Overview

g USIng the Web i Using Floor Plans
> USlng the Handheld [l Using the Dashboard

i Connections Overview

» Using the Desktop B Using Reports
. . i Using the Workflow Module
> InSta“atlon & TrOU blEShOOtlng i Manage Profile and Users
B Alerts
[l GUI Reference Tables
> You may expand any section by clicking on the associated icon Bl Using the Handheld

i Using the Desktop
[l 1nstallation and Troubleshooting

> The Search feature in the upper right hand corner will allow for key word searching and quickly
finding the information you need. cearch Al Files v
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Stay in Touch

To access the Private Cormant-CS user group:
https://www.linkedin.com/groups/4323060 or
email sales@Cormant.biz to join.

For Additional Help

If you would like additional help with any
4 aspect of Cormant-CS, contact your partner or
4 Cormant directly at support@Cormant.biz
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Cormant Customer Support

> USA/World Wide: +1 805 747 4178
> Australia: +61 (0)2 8518 1298

> Belgium: +32 (0)2 401 9240 Skype Chat:
> Germany: + 49 (0)6922 224 6223 '
cormant.support

Singapore: +65 3158 2022
UK: +44 (0)20 33 972 911

> Ireland: +353 1531 4869

> Ttaly: +39 02360 48279

> Netherlands: +31 (0)20 220 9036 Email:

» Poland: +48 (0)2 2206 2153 support@cormant.biz
’ Pl

>

» Skype Voice: cormant-sipl
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